The following is a presentation on Accessibility… all faculty should review starting on slide14 for hints for creating accessible documents for use in academic program delivery.

SB 1692 - Tennessee Higher Education Commission - As enacted, requires the executive director of THEC to convene an accessibility task force to develop recommendations for the general assembly related to ensuring accessibility of digital curricula for students with disabilities at state institutions of higher education. - Amends TCA Title 49, Chapter 7, Part 2 and Title 49, Chapter 7, Part 20. (signed in 2014)
Implementing Accessibility with IT: Supporting the Institution's Mission to Deliver Quality Education at UTM

Harriette L. Spiegel
Will Flowers
The University of Tennessee at Martin

44th Tennessee Higher Education IT Symposium 2015
Chattanooga, TN
April 19-21, 2015
ITC and UTM Disability Services: Working Together to Create Accessible Course Content

I – ITC and UTM Disability Services Working Together

II – Creating Accessible Course Content
I—ITC and UTM Disability Services Working Together

• Effects of Bureaucratic Islands
• The Old Way of Thinking about DSS
• Full College Experience
• Specialized Knowledge/Broad Awareness
• IT and DSS develop and grow together
• Diversity and Student Success
Bureaucratic Structure of Responsibility

- Everyone has their own island of responsibility (and accountability).
- “That’s not my job.”
- Benefits and demerits
- Too much knowledge/too many issues
- Student view of the university structure
- Student experience of the fragmentation of responsibility
The Old Way of Thinking

• Every aspect of a student’s college career is DSS responsibility.
• All liability rests with DSS not just for classroom accommodations and accessible materials, but for Housing modifications, registration, applications for scholarships, academic advising, etc.
• Contradicts the mission to assist SWD learn self-advocacy skills.
• The phrase “one of your students” comes up occasionally.
Right to a full college experience

• Unfair for every aspect of college experience to first filter through DSS.
• Other students feel at home in the university, SWD feel like unwelcome guests.
• Am I encouraging change that will slowly render my office obsolete?
• Students will always need to self-identify with DSS to receive academic accommodations—but do they need to self-identify to effectively use the website? To navigate their Blackboard course?
Specialized Knowledge/Broad Awareness

• DSS Professionals need specialized knowledge of:
  – Precedents and developments of higher education disability law.
  – Barriers to information access that SWD face.
  – We (I) often lack specialized knowledge of the best ways to bridge those barriers (or we lack the resources and authority to undertake the task).
  – But we need at least a broad awareness of how information technology affects SWD and their access to course content, and how information technology can help facilitate better access.
Specialized Knowledge/Broad Awareness

• IT Professionals have specialized knowledge of:
  – The functions, development, and implementation of information systems, applications, etc.
  – How to fix things.
  – At UTM, most already have at least a broad awareness of how information technology affects SWD and their access to course content, and how information technology can help facilitate better access.
  – But it isn’t their office’s responsibility to subscribe to Disability Compliance for Higher Education—that’s on me.
Shared Resources, Shared Knowledge, Shared Responsibilities

• Not trying to give anyone else my work.
• If a student cannot access a university website because it won’t interface with JAWS, do I:
  – Try to change it on my own?
  – Propose an alternative method—proctor the student’s navigation, click for them, do manually what the student cannot do independently (i.e. register for classes, navigate online learning platform, accept financial aid)?
  – Contact the webmaster and discuss the issue from a DSS perspective, and work together to facilitate necessary changes?
Shared Resources, Shared Knowledge, Shared Responsibilities

• No guarantee that I’m the first line of contact anyway.
  – Students have to register with DSS for academic (classroom) accommodations, but they don’t have to register with DSS to file a grievance regarding inaccessibility.

• Not just ITC—DSS touches every department on campus.
  – HR: Student workers
  – Housing: adjustments to campus living
  – Student life: participation in extracurricular activities
  – Dining services: allergies, electronic menus, accessible facilities
  – Event planning: interpreters, CART services at commencement, other public events
Institutional Responsibility/Best Interest of All

• Ultimate responsibility for access rests with the institution.

• Accessible/Inaccessible dilemma is only going to continue, progress, and alter going forward.

• Growth of technological disability/access issues is inextricable from, perhaps even concomitant to, the growth, institutional integration, and continued development of information technology in higher education.

• The importance of fluid cooperation and shared knowledge is steadily increasing.
Institutional Responsibility/Student Success and Retention

• According to NCES, 10-12% of postsecondary students self-identify as having a disability.

• Access for those students is not a favor, or an extra allowance, or a kindness—it is a civil rights issue.

• Renewed focus at the state level for timeliness of accommodations: “reasonable” not good enough.

• Have to have top level administrative buy-in for successful cooperative initiatives.

• Facilitates horizontal and vertical cooperation.
Institutional Responsibility/Student Success and Retention

- Creating an environment conducive to their success benefits the institution as well as the students.
- Essential to diversity initiatives and recruitment/retention strategies.
- Proactive future planning—IT and DSS cooperation has the potential to radically alter the expectations of the modern workplace, not just the classroom.
II--Creating Accessible Course Content

What is Digital Accessibility?

Think about the following:
Have you ever…

- Felt frustrated because a web page took a long time to load…
- Felt annoyed because the sound quality of an audio file was poor…
- Felt confused because a picture made no sense out of context…
- Realized you don’t lipread…?
For instance:

• YouTube of athletic presentation
What did you learn?

• Who is speaking?
• What is he speaking about?
• Anything about the speaker – where is he, most likely?
• What is your reaction?
Captions

• NAD -
  https://www.youtube.com/watch?feature=player_embedded&v=Ei8fyGwsyIo

• And YouTube with captions (show inadequacy of the captions rendition!)
  https://www.youtube.com/watch?v=R1MWwQG_Lkc

• Accessible view and text on
  http://www.utmsports.com/fullstory.cfm?id=8052&sport=BASEBALL
Transcript

• Matt Poteet, uh, was our starting pitcher today and he did a great job; it was his uh first start of the year and he went out through uh five and two-thirds good innings, through great innings, and uh, got through the order and just put us in a position, late in the game, to be able to score some runs and win. Fletcher Johnson also had a great game uh starting in center field, had a couple, three hits, stole a base, threw a guy with the plate uh. The other thing that he did that you don’t see in the box score is by him being in center field put Douglas in right field which Douglas was able to make about three catches out there that nobody else was going to catch, so it was a really good game today for those guys. We had some key hits there at the end; it was really important eco; uh it’s doubled down the line, scored two runs. Uh, that put us up so that we could walk the bases or have the bases loaded there in the end and not feel as much pressure as if it was a one-run game

• http://www.utmsports.com/fullstory.cfm?id=8052&sport=BASEBALL
What is Accessible Course Content?

• Created “with accessibility in mind”:
  – Universal design principles (NCSU - http://www.ncsu.edu/ncsu/design/cud/about_ud/udprinciples.htm)
  – ANYONE can easily access

• Guidelines and resources – VAST
  – Web Accessibility Initiative (WAI) - http://www.w3.org/WAI/
  – Web Accessibility Tutorials - http://www.w3.org/WAI/tutorials/
  – --WAI – Designing for Inclusion: http://www.w3.org/WAI/users/Overview.html
What are our options for solutions?

• Pay external parties to do the work – a long line of entities that will do it for $$$:

• Ignore at our peril and the resulting disservice to users

• DO IT OURSELVES
How screen readers work

• [http://webaim.org/techniques/screenreader/](http://webaim.org/techniques/screenreader/)

• convert text into synthesized speech so that users can listen to the content

• Any text – making sense or not
Microsoft Accessibility Checker

• Microsoft 2010
• Word, Excel, PPT

• https://support.office.com/en-us/article/Creating-accessible-Excel-workbooks-6cc05fc5-1314-48b5-8eb3-683e49b3e593?CorrelationId=da0e9401-2c80-4a82-b80a-ac6763901b87&ui=en-US&rs=en-US&ad=US
• https://support.office.com/en-au/article/Video-Check-accessibility-of-a-PowerPoint-2010-presentation-a911b631-d1ac-4ade-8130-20177752581c
Learn about Accessibility Checker

The Accessibility Checker checks your file against a set of possible issues for people who have disabilities might experience in your file. Each issue is classified as an Error, Warning, or Tip.

- **Error**  An error is for content that makes a file very difficult or impossible for people with disabilities to understand.

- **Warning**  A warning is for content that in most, but not all, cases makes a file difficult for people with disabilities to understand.

- **Tip**  A tip is for content that people with disabilities can understand, but that might be better organized or presented in a way that would improve their experience.

Fixing some issues might require you to change, reformat, or update your content.

The Accessibility Checker also lets you know about Office features you can use to make your content more accessible for detailed explanations of the issues the Accessibility Checker looks for, see Rules used by the Accessibility checker.
Information about IllustrateAccChecker

C:\Users\hsiegel\Desktop\IllustrateAccChecker.xlsx

Permissions
Anyone can open, copy, and change any part of this workbook.

Prepare for Sharing
Before sharing this file, be aware that it contains:
- Document properties and author’s name
- Content that people with disabilities find difficult to read

Inspect Document
Check the workbook for hidden properties or personal information.

Check Accessibility
Check the workbook for content that people with disabilities might find difficult to read.

Check Compatibility
Check for features not supported by earlier versions of Excel.
Desirable view of accessibility checker
To fix errors in accessibility:

- Word – use Headings instead of font size/color tools to correctly indicate hierarchy to the screen reader
- Use Alt Text for images
- A table in Word should be described in alt text
- Describe links (v. “click here”)
Titles and descriptions provide alternative, text-based representations of the information contained in tables, diagrams, images, and other objects. This information is useful for people with vision or cognitive impairments who may not be able to see or understand the object.

A title can be read to a person with a disability and is used to determine whether they wish to hear the description of the content.
Title:

tulips

Description:
yellow tulips with a blue sky in background; a red streak on one of the petals. Green stems and branches.

You can type alt text for tables, diagrams, images, and other objects. Screen readers can then read the alt text to people who may have difficulty seeing the objects.

The screen reader first reads the title. The person can then decide whether to hear a longer description.
On a Mac – the Apple Accessibility website (https://www.apple.com/accessibility/osx/)
To fix errors in accessibility:

- Excel – designate column and row headings
- Use Alt Text for images
- Do not use blank cells, rows, for formatting
In this article

- Add alternative text to images and objects
- Specify column header information in Excel tables
- Use hyperlink text that is meaningful
- **Avoid using blank cells, rows, or columns for formatting**
- Give all sheet tabs unique names
- Include closed captions for any audio or video
- Learn More
EXCEL tables

Specify column header information in Excel tables

In addition to adding alt text that describes the table, having clear column headings can help provide context and assist navigation of the table’s contents.

To specify a header row in a block of cells marked as a table, do the following:

1. Click anywhere in the table.

2. On the Table Tools Design tab, in the Table Style Options group, select the Header Row check box.

3. Add your header information.

To specify a header row in a new block of cells you are marking as table, do the following:

1. Highlight the cells you want to include in the table.

2. On the Insert tab, in the Tables group, click Table.

3. Select the My table has headers check box.

4. Click OK.

Home tab/ Styles/
Excel
### Example of Using the 'Format as Table' Feature

#### Steps:
1. Select the range of cells you want to convert into a Table.
2. Go to the 'Home' tab in the Excel ribbon.
3. Click on the 'Format as Table' button in the 'Styles' group.
4. Choose a pre-defined Table Style from the dropdown menu.

#### Example:

<table>
<thead>
<tr>
<th>Item</th>
<th>Quantity</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>#1</td>
<td>50</td>
<td>$5</td>
</tr>
<tr>
<td>#2</td>
<td>30</td>
<td>$10</td>
</tr>
<tr>
<td>#3</td>
<td>20</td>
<td>$15</td>
</tr>
</tbody>
</table>
To fix errors in accessibility:

- PowerPoint – Create an orderly progression of content
- Use Alt Text for images
- Describe links (v. “click here”)
- Use PPT’s slide templates (rather than creating text boxes)
PowerPoint

Practice PPT

Additional Information

How To Fix:
To check the order content will be read back:
1) Switch to the Home tab, click Arrange, and choose Selection Pane.
2) The Selection Pane lists the objects on the slide. Objects will be read back beginning with the bottom list item and ending with the top list item. Correct any out of order items using the Re-order arrows on the bottom of the pane.
Content Authoring

• WHAT: Use list tools (bullets – “unordered,” numbers – “ordered”) rather than spacing or tabs.

• WHY: gives user clear idea of how text is organized and length of content
Content Authoring

• **WHAT**: Use Headings feature that automatically designates the text as heading.

• **WHY**: users can understand the page’s organization and “scan” or navigate quickly to items of interest; screen reader tools allow jumping between headings.
Content Authoring

• WHAT: “Alternate text” for images that convey meaning (v. purely decorative)

• WHY: without “alt text,” images are ignored by the screen reader; description of image adds meaning; designer should properly mark up so screen reader ignores unnecessary images
Content Authoring

- **WHAT**: Tables – use for data; do not use for layout; clearly identify rows and column headers

- **WHY**: screen reader reads left to right; top to bottom, content is clear to listener

- **Spreadsheets**: [https://support.office.com/en-us/article/Creating-accessible-Excel-workbooks-6cc05fc5-1314-48b5-8eb3-683e49b3e593?CorrelationId=da0e9401-2c80-4a82-b80a-ac6763901b87&ui=en-US&rs=en-US&ad=US](https://support.office.com/en-us/article/Creating-accessible-Excel-workbooks-6cc05fc5-1314-48b5-8eb3-683e49b3e593?CorrelationId=da0e9401-2c80-4a82-b80a-ac6763901b87&ui=en-US&rs=en-US&ad=US)
Content Authoring

- What: identify document language
- Why: screen readers are multilingual
PDFs

- Start with an accessible document before converting to PDF.
University of Washington Overview

DO IT OURSELVES ("content authors")

- Train faculty to make it a habit to think *accessibility*
- Follow the lead of other universities:
  - University of Washington
  - Temple University -
Why do we care?

• “It’s the right thing to do.”
• Everybody is not equally perfect: we all benefit from accessible course content.
• We have to.
At our peril and disservice to users


• Laws: Tennessee – Senate Bill 1692
SB 1692 – signed into law 2014

• SB 1692 - Tennessee Higher Education Commission - As enacted, requires the executive director of THEC to convene an accessibility task force to develop recommendations for the general assembly related to ensuring accessibility of digital curricula for students with disabilities at state institutions of higher education. - Amends TCA Title 49, Chapter 7, Part 2 and Title 49, Chapter 7, Part 20.
Pay external parties $$$

- a long line of entities that will do it for $$$ and free (many listed but not found)
  - Access iQ (Australia)
  - WCAG Compliance (pdfs)
  - PubliRead (pdfs)
  - Crawford Technologies (pdfs)
  - European Blind Union
  - 508 Doc: electronic Document Compliance Services
  - RiverDocs Bureau Services
  - NCBI Working for People with Sight Loss (National Council for the Blind of Ireland) . . .
Free for all:

• U.S. Dept. of Health and Human Services
• Social Security Administration
• Learning Solutions Magazine
• Grand Valley State University
• Scottish Accessible Information Forum
• Accessible Books Consortium (Accessible Publishing Best Practice Guidelines for Publishers)
• Braille Works: Audio Documents for the Blind and Visually Impaired (508 Document Compliance)
• Daisy Consortium
THANK YOU!

• hspiegel@utm.edu

• wflower3@utm.edu